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Sub-Section Id : 2549894348
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Question Number : 1 Question Id : 2549896255 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Software
Sub Topic Operating Systems
Micro Topic Windows
Objective Knowledge
Section Familiarity with computer systems



Form SET 52
Files are organised by storing them in ______.
Options :
1.  tables
2.  databases
3.  folders
4.  graphs
  
Question Number : 1 Question Id : 2549896255 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Software
Sub Topic Operating Systems
Micro Topic Windows
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

______ म� �ोर करके फ़ाइल को �व��थत रखा जाता है।
Options :
1.  टेबल
2.  डेटाबेस
3.  फ़ो�र
4.  �ाफ़
  
Question Number : 2 Question Id : 2549896434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy



Item Year CPCT 2021
Topic Software
Sub Topic Computer Languages
Micro Topic Compiler
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
A tool that converts an entire program into machine language is called a/an:
Options :
1.  Interpreter
2.  Simulator
3.  Compiler
4.  Commander
  
Question Number : 2 Question Id : 2549896434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Software
Sub Topic Computer Languages
Micro Topic Compiler
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

एक पूरे �ो�ाम को मशीन की भाषा म� प�रवित�त करने वाला टूल ______ कहलाता है।
Options :
1.  इंटर�ेटर
2.  िस�ुलेटर
3.  क�ाइलर
4.  कमांडर



  
Question Number : 3 Question Id : 2549896490 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware
Sub Topic Generations types and parts of computers
Micro Topic Memory Unit
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
Which of the following is the fastest memory in a computer system?
Options :
1.  ROM
2.  RAM
3.  Cache
4.  Hard Disk
  
Question Number : 3 Question Id : 2549896490 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware
Sub Topic Generations types and parts of computers
Micro Topic Memory Unit
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

िन�िल�खत म� से कौनसी कं�ूटर �णाली (िस�म) सबसे तेज मेमोरी होती है?



Options :
1.  ROM
2.  RAM
3.  कैशे (Cache)
4.  हाड� िड�
  
Question Number : 4 Question Id : 2549896566 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware
Sub Topic Storage Devices
Micro Topic Others
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
As per the latest technology context the storage capacity of a hard drive is measured in:
Options :
1.  Bytes
2.  Terabytes
3.  Bits
4.  Nibble
  
Question Number : 4 Question Id : 2549896566 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware



Sub Topic Storage Devices
Micro Topic Others
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

नवीनतम �ौ�ोिगकी संदभ� के अनुसार हाड� ड� ाइव की भंडारण �मता को िकसम� मापा जाता है?
Options :
1.  बाइट्स
2.  टेराबाइट
3.  िबट्स
4.  िन� बल
  
Question Number : 5 Question Id : 2549896887 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware
Sub Topic Output Devices
Micro Topic Printer (impact oor non-impact)
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
The output of an image through a printer is often called ______.
Options :
1.  soft copy
2.  hard copy
3.  large copy
4.  small copy
  
Question Number : 5 Question Id : 2549896887 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware
Sub Topic Output Devices
Micro Topic Printer (impact oor non-impact)
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

ि�ंटर के मा�म से एक छिव की आउटपुट को अ�र ______ कहा जाता है।
Options :
1.  सॉ� कॉपी
2.  हाड� कॉपी
3.  लाज� कॉपी
4.  �ॉल कॉपी
  
Question Number : 6 Question Id : 2549896889 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware
Sub Topic Input Devices
Micro Topic Keyboard
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
Which of the following keys is known as a toggle key?
Options :
1.  Num Lock



2.  Delete
3.  Alt
4.  Control
  
Question Number : 6 Question Id : 2549896889 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Hardware
Sub Topic Input Devices
Micro Topic Keyboard
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

िन� म� से कौन सी कंुजी को टॉगल की (कंुजी) के �प म� जाना जाता है?
Options :
1.  Num Lock
2.  Delete
3.  Alt
4.  Control
  
Question Number : 7 Question Id : 2549896325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Software
Sub Topic Proprietary Software
Micro Topic Microsoft Office



Objective Application
Section Familiarity with computer systems
Form SET 52
Which of the following is a database management system?
Options :
1.  MS Word
2.  MS Access 
3.  MS Excel
4.  MS PowerPoint
  
Question Number : 7 Question Id : 2549896325 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Software
Sub Topic Proprietary Software
Micro Topic Microsoft Office
Objective Application
Section Familiarity with computer systems
Form SET 52

िन�िल�खत म� से कौन सा डेटाबेस �बंधन �णाली (डेटाबेस मैनेजम�ट िस�म) है?
Options :
1.  MS Word
2.  MS Access
3.  MS Excel
4.  MS PowerPoint
  
Question Number : 8 Question Id : 2549896332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :



Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Software
Sub Topic Application Software
Micro Topic Database
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
The ______ data type is used to store numbers only.
Options :
1.  memo
2.  text
3.  number
4.  date / time
  
Question Number : 8 Question Id : 2549896332 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Software
Sub Topic Application Software
Micro Topic Database
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

______ डेटा �कार का उपयोग केवल सं�ाओ ंको �ोर करने के िलए िकया जाता है।
Options :
1.  मेमो
2.  टे�
3.  नंबर



4.  िदनांक / समय
  
Question Number : 9 Question Id : 2549896438 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Hardware
Sub Topic Generations types and parts of computers
Micro Topic Memory Unit
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
How CPU reads the information from secondary memory?
Options :
1.  First information is transferred to main memory and from there, the CPU reads
2.  Directly from secondary memory
3.  Through registers
4.  Through bus
  
Question Number : 9 Question Id : 2549896438 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Hardware
Sub Topic Generations types and parts of computers
Micro Topic Memory Unit
Objective Knowledge
Section Familiarity with computer systems
Form SET 52



ि�तीय मेमोरी म� से सीपीयू (CPU) सूचना को कैसे पढ़ता है?
Options :
1.  पहले सूचना को मु� मेमोरी म� �थानांत�रत िकया जाता है और वहां से सीपीयू (CPU) पढ़ता है
2.  सीधे ि�तीय मेमोरी से पढ़ता है 
3.  रिज�र के �ारा
4.  बस के �ारा
  
Question Number : 10 Question Id : 2549897583 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Hardware
Sub Topic Storage Devices
Micro Topic Others
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
Full form of EPROM is:
Options :
1.  Erasable Programmable Read Only Memory
2.  Exponential Programmable Read Only Memory
3.  Expandable Programmable Read Only Memory
4.  Extensive Programmable Read Only Memory
  
Question Number : 10 Question Id : 2549897583 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021



Topic Hardware
Sub Topic Storage Devices
Micro Topic Others
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

EPROM का पूरा �प �ा है?
Options :
1.  इरेजेबल �ो�ामेबल रीड ओनली मेमोरी (Erasable Programmable Read Only Memory)
2.  ए�पोन��िशयल �ो�ामेबल रीड ओनली मेमोरी (Exponential Programmable Read Only Memory)
3.  ए�प�डेबल �ो�ामेबल रीड ओनली मेमोरी (Expandable Programmable Read Only Memory)
4.  ए���िसव �ो�ामेबल रीड ओनली मेमोरी (Extensive Programmable Read Only Memory)
  
Question Number : 11 Question Id : 2549897721 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Hardware
Sub Topic Input Devices
Micro Topic Touch Screen
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
Which of the following is used in automated teller machines or public information kiosks?
Options :
1.  Touch screens
2.  Pens
3.  Microphones
4.  Stylus
  



Question Number : 11 Question Id : 2549897721 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Hardware
Sub Topic Input Devices
Micro Topic Touch Screen
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

िन�िल�खत म� से िकसका उपयोग �चािलत टेलर मशीनो ंया साव�जिनक सूचना बूथो ंम� िकया जाता है?
Options :
1.  टच �ीन
2.  कलम / पेन
3.  माइ�ोफोन
4.  �ाइलस (Stylus)
  
Question Number : 12 Question Id : 25498913740 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Hardware
Sub Topic Output Devices
Micro Topic Printer (impact oor non-impact)
Objective Understanding
Section Familiarity with computer systems
Form SET 52
How many minimum number of cartridges does an inkjet colour printer have?
Options :



1.  Five
2.  Three
3.  Two
4.  Four
  
Question Number : 12 Question Id : 25498913740 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Hardware
Sub Topic Output Devices
Micro Topic Printer (impact oor non-impact)
Objective Understanding
Section Familiarity with computer systems
Form SET 52

इंकजेट कलर ि�ंटर म� �ूनतम िकतने कािट� �ज होते ह�?
Options :
1.  पांच
2.  तीन
3.  दो
4.  चार
  
Question Number : 13 Question Id : 2549897277 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Software
Sub Topic Operating Systems



Micro Topic Linux
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
Which option is used with "Is" command to list all files including hidden files in Linux?
Options :
1.  -a
2.  -x
3.  -i
4.  -r
  
Question Number : 13 Question Id : 2549897277 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Software
Sub Topic Operating Systems
Micro Topic Linux
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

िलन� (Linux) म�, िछपी �ई फाइलो ंसिहत सभी फाइलो ंको सूचीब� करने के िलए "Is" कमांड के साथ िकस िवक� का उपयोग िकया जाता है?
Options :
1.  -a
2.  -x
3.  -i
4.  -r
  
Question Number : 14 Question Id : 2549897858 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Software
Sub Topic Proprietary Software
Micro Topic Microsoft Office
Objective Knowledge
Section Familiarity with computer systems
Form SET 52
From the given options, which window can be split into two panes in MS Access?
Options :
1.  Design view
2.  Active
3.  Passive
4.  Procedure
  
Question Number : 14 Question Id : 2549897858 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Software
Sub Topic Proprietary Software
Micro Topic Microsoft Office
Objective Knowledge
Section Familiarity with computer systems
Form SET 52

िदए गए िवक�ो ंम� से कौन MS Access म� िवंडो को दो फलको ंम� िवभािजत करता है?
Options :
1.  िडजाइन �ू
2.  ए��व



3.  पैिसव
4.  �ोसीज़र
  
Question Number : 15 Question Id : 2549898684 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Software
Sub Topic Open Source Software
Micro Topic Open Office
Objective Understanding
Section Familiarity with computer systems
Form SET 52

ओपन ऑिफस कै� (OpenOffice Calc) म� फं�न ISEVEN(2.1) का �ा आउटपुट होगा?
Options :
1.  FALSE
2.  TRUE
3.  EVEN
4.  ODD
  
Question Number : 15 Question Id : 2549898684 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Software
Sub Topic Open Source Software
Micro Topic Open Office
Objective Understanding



Section Familiarity with computer systems
Form SET 52
What will be the output for the function ISEVEN(2.1) in an OpenOffice Calc?
Options :
1.  FALSE
2.  TRUE
3.  EVEN
4.  ODD
  
Question Number : 16 Question Id : 2549899558 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic File Management
Sub Topic Printing
Micro Topic Setting up Printer
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
First dot matrix printer was introduced by ______.
Options :
1.  Microsoft
2.  Epson
3.  Centronics
4.  Cannon
  
Question Number : 16 Question Id : 2549899558 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :



Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic File Management
Sub Topic Printing
Micro Topic Setting up Printer
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

पहला डॉट मैिट� � ि�ंटर _____ के �ारा पेश िकया गया था।
Options :
1.  माइ�ोसॉ� (Microsoft)
2.  ए�न (Epson)
3.  स�टरोिन� (Centronics)
4.  केनन (Cannon)
  
Question Number : 17 Question Id : 25498913388 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic File Management
Sub Topic Compressing files
Micro Topic Others
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
A codec is a device or software that is used to ______ or ______ a digital media file, such as a video or song.
Options :
1.  store, transfer



2.  lock, unlock
3.  compress, decompress
4.  delete, recover
  
Question Number : 17 Question Id : 25498913388 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic File Management
Sub Topic Compressing files
Micro Topic Others
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

कोडेक एक िडवाइस या सॉ�टवेयर है िजसका उपयोग िडिजटल मीिडया फ़ाइल जैसे वीिडयो या गीत को _____ अथवा ______ करने के िलए िकया जाता है।
Options :
1.  �ोर, ट� ा�फर
2.  लॉक, अनलॉक
3.  संपीिडत, असंपीिडत (कं�ेस, िडकं�ेस)
4.  िडलीट, �रकवर
  
Question Number : 18 Question Id : 25498913940 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Computer setup
Sub Topic Connecting to a network



Micro Topic Logging on and off to a network
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
Which of the following acts as an intermediary between client and server in case client requests from the server?
Options :
1.  Switches
2.  Router
3.  Firewall
4.  Proxy server
  
Question Number : 18 Question Id : 25498913940 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Computer setup
Sub Topic Connecting to a network
Micro Topic Logging on and off to a network
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

सव�र से �ाइंट अनुरोध के मामले म� �ाइंट और सव�र के बीच म��थ के �प म� कौन काय� करता है?
Options :
1.  ��च
2.  राउटर (Router)
3.  फ़ायरवॉल
4.  �ॉ�ी सव�र
  



Question Number : 19 Question Id : 25498918432 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Printing
Micro Topic Configuring default printer
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
If you print two copies of a three-page document and you choose NOT to collate them then:
Options :
1.  Pages print in this order: 1, 2, 1, 2, 3, 3
2.  pages print in this order: 1, 1, 2, 2, 3, 3
3.  Pages print in this order: 1, 2, 3, 1, 2, 3
4.  Pages print in this order: 1, 3, 2, 1, 3, 2
  
Question Number : 19 Question Id : 25498918432 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Printing
Micro Topic Configuring default printer
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

यिद आप तीन पृ� के द�ावेज़ की दो �ितिलिपयां मुि�त करते है और उ�� कोलेट (collate) करने का िवक� नही ंचुनते ह� तो:
Options :



1.  पृ� िन�ांिकत �म म� मुि�त होगें: 1, 2, 1, 2, 3, 3
2.  पृ� िन�ांिकत �म म� मुि�त होगें: 1, 1, 2, 2, 3, 3
3.  पृ� िन�ांिकत �म म� मुि�त होगें: 1, 2, 3, 1, 2, 3
4.  पृ� िन�ांिकत �म म� मुि�त होगें: 1, 3, 2, 1, 3, 2
  
Question Number : 20 Question Id : 25498918526 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Preferences in an OS
Micro Topic Configuring OS
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
Which of the following is NOT an operating system?
Options :
1.  MS DOS
2.  Windows 7
3.  Opera
4.  Linux
  
Question Number : 20 Question Id : 25498918526 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Preferences in an OS



Micro Topic Configuring OS
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

िन�िल�खत म� से कौन ऑपरेिटंग िस�म नही ंहै?
Options :
1.  MS DOS
2.  Windows 7
3.  Opera
4.  Linux
  
Question Number : 21 Question Id : 25498922639 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Computer setup
Sub Topic Troubleshooting
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
With respect to computer booting, BIOS stands for:
Options :
1.  Basic input output system
2.  Binary input output system
3.  Binary in-out selection
4.  Basic input output storage
  
Question Number : 21 Question Id : 25498922639 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Computer setup
Sub Topic Troubleshooting
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

कं�ूटर बूिटंग के संदभ� म�, बी.आई.ओ.एस. (BIOS) का �ा अथ� होता है?
Options :
1.  बेिसक इनपुट आउटपुट िस�म (Basic input output system)
2.  बाइनरी इनपुट आउटपुट िस�म (Binary input output system)
3.  बाइनरी इन-आउट सेले�न (Binary in-out selection)
4.  बेिसक इनपुट आउटपुट �ोरेज (Basic input output storage)
  
Question Number : 22 Question Id : 2549897355 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic File Management
Sub Topic File formats
Micro Topic Identifying and selecting suitable file formats and using them for transferring data
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
Which file format is used to save Assembler source code?
Options :
1.  .asc



2.  .asm
3.  .asmsc
4.  .asmc
  
Question Number : 22 Question Id : 2549897355 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic File Management
Sub Topic File formats
Micro Topic Identifying and selecting suitable file formats and using them for transferring data
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

असे�लर सोस� कोड को सहेजने के िलए कौन से फ़ाइल फॉम�ट का उपयोग िकया जाता है?
Options :
1.  .asc
2.  .asm
3.  .asmsc
4.  .asmc
  
Question Number : 23 Question Id : 2549898137 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Data encryption



Micro Topic Keeping personal data private and secure
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
Authorized access is usually granted by entering your username and ______.
Options :
1.  MAC address
2.  IP address
3.  password
4.  system name
  
Question Number : 23 Question Id : 2549898137 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Data encryption
Micro Topic Keeping personal data private and secure
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

अिधकृत प�ँच आमतौर पर अपने उपयोगकता� नाम (यूजर नेम) और ______ डालने पर िमलती है।
Options :
1.  MAC पता
2.  IP पता
3.  पासवड�
4.  िस�म नाम
  



Question Number : 24 Question Id : 2549898222 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Virus protection
Micro Topic Others
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
Many websites use a _______ to define their security and identity.
Options :
1.  code
2.  certificate
3.  program
4.  protocol
  
Question Number : 24 Question Id : 2549898222 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Virus protection
Micro Topic Others
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock



कई वेबसाइट� अपनी सुर�ा और पहचान को प�रभािषत करने के िलए ______ का उपयोग करती ह�।
Options :
1.  कोड
2.  �माणप� (सिट�िफकेट)
3.  �ो�ाम
4.  �ोटोकॉल
  
Question Number : 25 Question Id : 25498910756 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Computer setup
Sub Topic Setting up a new device
Micro Topic Printer (impact oor non-impact)
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
A laser printer generates a totally black page. What is the cause?
Options :
1.  No power to primary corona
2.  Malfunctioning imaging laser
3.  No power to transfer corona
4.  No level in toner cartridge
  
Question Number : 25 Question Id : 25498910756 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium



Item Year CPCT 2021
Topic Computer setup
Sub Topic Setting up a new device
Micro Topic Printer (impact oor non-impact)
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

लेजर ि�ंटर म� िन� म� से कौन सी सम�ा के कारण, एक काला पृ� ि�ंट िकया जाता है?
Options :
1.  �ाथिमक कोरोना के िलए कोई पॉवर नही ं
2.  इमेिजंग लेजर खराब होना
3.  कोरोना �थानांत�रत करने के िलए कोई पॉवर नही ं
4.  टोनर कािट� �ज म� कोई �र नही ं
  
Question Number : 26 Question Id : 25498910987 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Computer setup
Sub Topic Connecting to a network
Micro Topic Others
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
A hybrid network topology is a combination of ______ different basic network topologies.
Options :
1.  Infinite
2.  Only five
3.  Only two



4.  Two or more
  
Question Number : 26 Question Id : 25498910987 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Computer setup
Sub Topic Connecting to a network
Micro Topic Others
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

एक हाइि�ड नेटवक�  टोपोलॉजी, ______ िविभ� नेटवक�  टोपोलॉजीस का संयोजन होता है।
Options :
1.  अनंत
2.  केवल पांच
3.  केवल दो
4.  दो या अिधक
  
Question Number : 27 Question Id : 25498913384 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic File Management
Sub Topic Compressing files
Micro Topic Others
Objective Understanding



Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
Which of the following number systems uses only two different symbols to represent data?
Options :
1.  Decimal
2.  Hexadecimal
3.  Binary
4.  Octal
  
Question Number : 27 Question Id : 25498913384 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic File Management
Sub Topic Compressing files
Micro Topic Others
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

िन� म� से िकस सं�ा प�ित म� आंकड़े िन�िपत करने के िलए केवल दो िभ� �तीको ंका उपयोग होता है?
Options :
1.  दशमलव (Decimal)
2.  षोडश आधारी (Hexadecimal)
3.  ि�आधारी (Binary)
4.  अ�ाधारी (Octal)
  
Question Number : 28 Question Id : 2549899512 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic File Management
Sub Topic Printing
Micro Topic Printing to a file
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
What is the length of the IPv4 address?   
Options :
1.  32 bits
2.  32 bytes
3.  64 bits
4.  64 bytes
  
Question Number : 28 Question Id : 2549899512 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic File Management
Sub Topic Printing
Micro Topic Printing to a file
Objective Knowledge
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

IPv4 पते की लंबाई �ा होती है?
Options :



1.  32 िबट्स
2.  32 बाइट्स
3.  64 िबट्स
4.  64 बाइट्स
  
Question Number : 29 Question Id : 25498911281 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Computer setup
Sub Topic Audio controls
Micro Topic Audio conferencing
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
Relationship between amplitude and frequency is represented by:
Options :
1.  phase-domain plot
2.  time-domain plot
3.  frequency-domain plot
4.  amplitude-domain plot
  
Question Number : 29 Question Id : 25498911281 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Computer setup



Sub Topic Audio controls
Micro Topic Audio conferencing
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

ए�ली�ूड और �ी�� सी के बीच संबंध को िकस �कार दशा�या जाता है?
Options :
1.  फेज-डोमेन �ॉट
2.  टाइम-डोमेन �ॉट
3.  �ी�� सी-डोमेन �ॉट
4.  ए�ली�ूड-डोमेन �ॉट
  
Question Number : 30 Question Id : 25498924380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Setting up of opertaing system
Micro Topic Others
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock
The ping command is not useful for the following:
Options :
1.  tracking and isolating network hardware and software problems.
2.  determining the status of the network and various foreign hosts.
3.  testing, measuring, and managing networks.
4.  changing the passwords of the machines connected to the network.



  
Question Number : 30 Question Id : 25498924380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic System and Security Administration
Sub Topic Setting up of opertaing system
Micro Topic Others
Objective Understanding
Section Knowledge of basic computer operations
Form SET 68
BankStatus Mock

िपंग कमांड िन�िल�खत म� िकसके िलए उपयोगी नही ंहोती है?
Options :
1.  नेटवक�  हाड�वेयर और सॉ�वेयर की सम�ाओ ंपर नज़र रखने और उ�� पृथक करने।
2.  नेटवक�  और िविभ� िवदेशी हो� की ��थित को सुिनि�त करने।
3.  नेटवक� की जांच, मापन और �बंधन करने।
4.  नेटवक�  से जुड़ी मशीनो ंके पासवड� को बदलने।
  
Question Number : 31 Question Id : 2549896686 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Presentation Skills
Micro Topic Powerpoint Other Slides
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52



MS PowerPoint 2007 म�, �ाइड सॉट�र कमांड, िकस �रबन टैब के अंतग�त पाया जाता है?
Options :
1.  Insert
2.  Design
3.  View
4.  Home
  
Question Number : 31 Question Id : 2549896686 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Presentation Skills
Micro Topic Powerpoint Other Slides
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
In MS PowerPoint 2007, slide sorter command is found under which ribbon tab?
Options :
1.  Insert
2.  Design
3.  View
4.  Home
  
Question Number : 32 Question Id : 2549897113 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021



Topic Internet Skills
Sub Topic Online collaboration
Micro Topic Others
Objective Understanding
Section Proficiency in general IT skills
Form SET 52

MSN एक ऐसी वेब सिव�स है िजसे सबसे पहले िकसके �ारा �दान िकया गया था?
Options :
1.  Linux
2.  Unix
3.  Microsoft
4.  Ubuntu
  
Question Number : 32 Question Id : 2549897113 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Internet Skills
Sub Topic Online collaboration
Micro Topic Others
Objective Understanding
Section Proficiency in general IT skills
Form SET 52
MSN is a Web service which was first provided by:
Options :
1.  Linux
2.  Unix
3.  Microsoft
4.  Ubuntu
  



Question Number : 33 Question Id : 2549897369 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document formatting
Micro Topic Others
Objective Application
Section Proficiency in general IT skills
Form SET 52

आप िन� म� से िकस टैब का उपयोग करके वड� द�ावेज़ म� पृ� सं�ा जोड़ सकते ह�?
Options :
1.  Design
2.  Insert
3.  Layout
4.  Format
  
Question Number : 33 Question Id : 2549897369 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document formatting
Micro Topic Others
Objective Application
Section Proficiency in general IT skills
Form SET 52
Which of the following tabs is used to add a page number in word document? 
Options :



1.  Design
2.  Insert
3.  Layout
4.  Format
  
Question Number : 34 Question Id : 2549897380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Common word processing keyboard commands
Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Application
Section Proficiency in general IT skills
Form SET 52
What is the correct key / key combination to be used to delete one word to the left of the cursor point in MS Word?
Options :
1.  CTRL+DELETE
2.  CTRL+BACKSPACE
3.  DELETE
4.  BACKSPACE
  
Question Number : 34 Question Id : 2549897380 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Common word processing keyboard commands



Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Application
Section Proficiency in general IT skills
Form SET 52

MS Word म� कस�र िबंदु के बाईं ओर एक श� को िमटाने के िलए सही कंुजी / कंुजी संयोजन �ा है?
Options :
1.  CTRL+DELETE
2.  CTRL+BACKSPACE
3.  DELETE
4.  BACKSPACE
  
Question Number : 35 Question Id : 2549897397 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Miscellaneous Document Processing Skills
Micro Topic Others
Objective Application
Section Proficiency in general IT skills
Form SET 52
Next footnote option is available in which menu tab of MS Word 2016?
Options :
1.  TABLE
2.  FORMAT
3.  INSERT
4.  REFERENCES
  
Question Number : 35 Question Id : 2549897397 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Miscellaneous Document Processing Skills
Micro Topic Others
Objective Application
Section Proficiency in general IT skills
Form SET 52

MS Word 2016 के िकस मेनू टैब म� अगला फुटनोट (next footnote) िवक� उपल� है?
Options :
1.  TABLE
2.  FORMAT
3.  INSERT
4.  REFERENCES
  
Question Number : 36 Question Id : 2549897478 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Presentation Skills
Micro Topic Others
Objective Application
Section Proficiency in general IT skills
Form SET 52
What is the key combination to change the pointer to a pen in a slide show mode in MS PowerPoint?
Options :
1.  ALT+P
2.  CTRL+P



3.  CTRL+A
4.  ALT+A
  
Question Number : 36 Question Id : 2549897478 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Presentation Skills
Micro Topic Others
Objective Application
Section Proficiency in general IT skills
Form SET 52

MS PowerPoint म� �ाइड शो मोड म� पॉइंटर को पेन म� बदलने के िलए कंुजी संयोजन �ा है?
Options :
1.  ALT+P
2.  CTRL+P
3.  CTRL+A
4.  ALT+A
  
Question Number : 37 Question Id : 2549898054 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Graphs
Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge
Section Proficiency in general IT skills



Form SET 52
Which of the following is NOT a variant of the Pie chart?
Options :
1.  Doughnut
2.  Line
3.  Spie
4.  Ring
  
Question Number : 37 Question Id : 2549898054 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Graphs
Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

िन�िल�खत म� से कौन सा पाई चाट� का �कार नही ंहै?
Options :
1.  डोनट
2.  लाइन
3.  �ाई
4.  �रंग
  
Question Number : 38 Question Id : 2549898063 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy



Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Graphs
Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
To represent the information in the same order on each bar ______ chart is useful in MS Excel.
Options :
1.  doughnut
2.  line
3.  radar
4.  stacked
  
Question Number : 38 Question Id : 2549898063 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Graphs
Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

��ेक बार म� एक ही �म म� सूचना (इनफाम�शन) को ��ुत करने के िलए MS Excel म� ______ चाट� उपयोगी होता है।
Options :
1.  डोनट
2.  लाइन
3.  रडार
4.  �ै�ड 



  
Question Number : 39 Question Id : 25498919153 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic General IT Skills
Sub Topic Mailmerge
Micro Topic Creating template for letters, envelopes, etc
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
When you click on envelopes icon in create group of Mailing tab in MS Word 2016, ______ dialogue box will be opened.
Options :
1.  Envelopes
2.  Labels
3.  Envelopes and Labels
4.  Create envelope
  
Question Number : 39 Question Id : 25498919153 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic General IT Skills
Sub Topic Mailmerge
Micro Topic Creating template for letters, envelopes, etc
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

जब आप MS Word 2016 म� ि�एट �ुप ऑफ़ मेिलंग टैब म� ए�ेलप (envelope) के आइकन पर ��क कर� गे, तो ______ संवाद (डायलॉग) बॉ� खुल



जाएगा।
Options :
1.  Envelopes
2.  Labels
3.  Envelopes and Labels
4.  Create envelope
  
Question Number : 40 Question Id : 2549896389 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Internet Skills
Sub Topic Search engine
Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
Which of the following is a popular Web search engine used worldwide?
Options :
1.  Intel
2.  Google
3.  Apple
4.  WWW
  
Question Number : 40 Question Id : 2549896389 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021



Topic Internet Skills
Sub Topic Search engine
Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

िन� म� से कौन सा एक लोकि�य वेब खोज इंजन दुिनया भर म� उपयोग िकया जाता है?
Options :
1.  Intel
2.  Google
3.  Apple
4.  WWW
  
Question Number : 41 Question Id : 2549897104 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Internet Skills
Sub Topic Internet Services
Micro Topic Email
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
In Gmail, ______ tab is used for notifications of bills and statements.
Options :
1.  updates
2.  promotions
3.  forums
4.  primary
  



Question Number : 41 Question Id : 2549897104 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Internet Skills
Sub Topic Internet Services
Micro Topic Email
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

Gmail म�, ______ टैब का उपयोग िबलो ंऔर कथनो ंकी अिधसूचनाओ ंके िलए िकया जाता है।
Options :
1.  अ�तन (अ�डेट)
2.  िव�ापन (�मोशन)
3.  फोरम 
4.  �ाथिमक
  
Question Number : 42 Question Id : 2549898032 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Graphs
Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
Which of the following is NOT a Line chart?
Options :



1.  Radar
2.  Stacked
3.  100% Stacked
4.  3-D
  
Question Number : 42 Question Id : 2549898032 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Graphs
Micro Topic Creating graphs like bar, pie, line, etc from the data provided in a table
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

िन�िल�खत म� से कौन सा िवक� लाइन चाट� नही ंहै?
Options :
1.  रडार
2.  �ै�ड
3.  100% �ै�ड
4.  3-D
  
Question Number : 43 Question Id : 25498910468 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Editing a document



Micro Topic Font type, font size
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
We can apply ______ different change case using Shift+F3 to selected paragraph.
Options :
1.  one
2.  two
3.  three
4.  four
  
Question Number : 43 Question Id : 25498910468 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Editing a document
Micro Topic Font type, font size
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

हमको चयिनत पैरा�ाफ म� Shift+F3 का �योग करके ______ िभ� प�रवत�न केस लागू कर सकते ह�।
Options :
1.  एक
2.  दो
3.  तीन
4.  चार
  
Question Number : 44 Question Id : 25498910529 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document Layout
Micro Topic Sizes
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
Deepu doesn't want to use any one of the standard paper sizes on the "size" menu to print an MS Word document. In that case, he has to click
'More Paper Sizes' options, which is at the ______ of the Size menu.
Options :
1.  bottom 
2.  top 
3.  left 
4.  right 
  
Question Number : 44 Question Id : 25498910529 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document Layout
Micro Topic Sizes
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

दीपू MS Word द�ावेज़ मुि�त करने के िलए "साइज़" मेनू (Size Menu) पर िकसी भी मानक पेपर आकार का उपयोग नही ंकरना चाहते ह�। उस ��थित म�,
उसे 'More Paper Sizes' पर ��क करना होगा जो साइज़ मेनू (Size Menu) के ______ है।
Options :



1.  नीचे की ओर
2.  ऊपर की ओर
3.  बाएं की ओर
4.  दाएं की ओर
  
Question Number : 45 Question Id : 25498912487 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document formatting
Micro Topic Header and footer
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
What is the difference between header & footer?
Options :
1.  Header puts an appearance at the top while footer gives an information about how the document looks.
2.  Footer is placed at top and header at top.
3.  Header gives information about appearance at every page while footer helps how the page looks.
4.  Header is placed at top wile footer is placed at bottom.
  
Question Number : 45 Question Id : 25498912487 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document formatting



Micro Topic Header and footer
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

हेडर और फुटर म� �ा अंतर है?
Options :
1.  हेडर ऊपर िदखाई देता है जबिक फुटर डॉ�ूम�ट के बारे म� जानकारी देता है िक वह कैसा िदखाई देगा।
2.  फुटर को ऊपर रखा जाता है और हेडर ऊपर रखा जाता है।
3.  हेडर ��ेक पेज पर उप��थित के बारे म� जानकारी देता है जबिक फुटर, पेज कैसा िदखता है इसम� सहायता करता है।
4.  हेडर को ऊपर रखा जाता है जबिक फुटर को नीचे रखा जाता है।
  
Question Number : 46 Question Id : 25498913288 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Macros
Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
How to enable macros in MS Excel 2000 and 2003?
Options :
1.  In Microsoft Excel navigate to File > Options > Trust Center > Trust Center Settings
2.  Click the Microsoft Office Button > Access Options > Trust Center > Trust Center Settings > Macro Settings
3.  In Microsoft Excel navigate to Tools tab > Macro > Security
4.  Click the Microsoft Office Button > Excel Options > Security
  
Question Number : 46 Question Id : 25498913288 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Macros
Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

MS Excel 2000 और 2003 म� मै�ोज़ को कैसे स�म कर�?
Options :
1.  In Microsoft Excel navigate to File > Options > Trust Center > Trust Center Settings
2.  Click the Microsoft Office Button > Access Options > Trust Center > Trust Center Settings > Macro Settings
3.  In Microsoft Excel navigate to Tools tab > Macro > Security
4.  Click the Microsoft Office Button > Excel Options > Security
  
Question Number : 47 Question Id : 25498913292 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Macros
Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
Which of the following functions CANNOT be achieved by writing macros in MS Excel?
Options :
1.  Compression of data and text
2.  Apply style and formatting



3.  Create entirely new documents
4.  Manipulate data and text
  
Question Number : 47 Question Id : 25498913292 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Macros
Micro Topic Others
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

MS Excel म� मै�ोज़ िलखकर िन� म� से कौन सा फ़ं�न �ा� नही ंिकया जा सकता है?
Options :
1.  डेटा और टे� का संपीडन (क�ेशन)
2.  शैली (Style) और ��पण (Formatting) लागू करना 
3.  पूण� �प से नए द�ावेज़ बनाना
4.  डेटा और टे� मेनी�ूलेट करना
  
Question Number : 48 Question Id : 25498924864 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Presentation Skills
Micro Topic Pivot tables
Objective Application



Section Proficiency in general IT skills
Form SET 52
What keys do you need to press on the key board to insert a $?
Options :
1.  Ctrl+4
2.  Shift+4
3.  Alt+4
4.  Enter+4
  
Question Number : 48 Question Id : 25498924864 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Presentation Skills
Micro Topic Pivot tables
Objective Application
Section Proficiency in general IT skills
Form SET 52

$ डालने के िलए आपको कीबोड� पर िकन कंुिजयो ंको दबाने की आव�कता है?
Options :
1.  Ctrl+4
2.  Shift+4
3.  Alt+4
4.  Enter+4
  
Question Number : 49 Question Id : 25498911489 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value



Difficulty Level Difficult
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Editing a document
Micro Topic Antivirus software
Objective Understanding
Section Proficiency in general IT skills
Form SET 52
In the Find and Replace feature of MS Word, "Find What" is the word to be searched, and "______" is the word for replacement.
Options :
1.  Replace with
2.  Replace for
3.  Change with
4.  Change for
  
Question Number : 49 Question Id : 25498911489 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Editing a document
Micro Topic Antivirus software
Objective Understanding
Section Proficiency in general IT skills
Form SET 52

MS Word के Find and Replace वैिश�� (फीचर) म�, "Find What" श� खोजा जाने वाला श� है,और "______" �ित�थापन के िलए श� है।
Options :
1.  Replace with
2.  Replace for
3.  Change with
4.  Change for



  
Question Number : 50 Question Id : 25498911843 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document Layout
Micro Topic Spacing
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
How many number of controls are there in Indent and Spacing tab in MS Word?
Options :
1.  1
2.  2
3.  3
4.  4
  
Question Number : 50 Question Id : 25498911843 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Document Processing Skills
Sub Topic Document Layout
Micro Topic Spacing
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

MS Word म� इंड�ट और �ेिसंग टैब म� िकतने िनयं�ण होते है?



Options :
1.  1
2.  2
3.  3
4.  4
  
Question Number : 51 Question Id : 25498918936 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Common keyboard commands for spreadsheets
Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
How will you turn on sticky keys in Windows 7 or Vista?
Options :
1.  Press shift button for 8 seconds
2.  Press shift button for 5 times in a row
3.  Presses NumLock for 5 seconds
4.  Using Tab+Shift
  
Question Number : 51 Question Id : 25498918936 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Numeric Skills



Sub Topic Common keyboard commands for spreadsheets
Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

Windows 7 or Vista म� आप ��की कंुजी कैसे चालू कर� गे?
Options :
1.  िश� (shift) बटन को 8 सेकंड के िलए दबाएं
2.  िश� (shift) बटन लगातार 5 बार दबाएं
3.  NumLock को 5 सेकंड के िलए दबाएं
4.  Tab+Shift का �योग कर के 
  
Question Number : 52 Question Id : 25498918959 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Common keyboard commands for spreadsheets
Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52
Which key combination is used to open the system properties in Windows?
Options :
1.  WINDOWS KEY+F
2.  WINDOWS KEY+E
3.  WINDOWS KEY+PAUSE/BREAK
4.  WINDOWS KEY+R
  
Question Number : 52 Question Id : 25498918959 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Numeric Skills
Sub Topic Common keyboard commands for spreadsheets
Micro Topic Commands used by pressing Ctrl/ Shift/ Alt key and other keys
Objective Knowledge
Section Proficiency in general IT skills
Form SET 52

Windows म� आप िस�म �ापट� को िकस कंुजी संयोजन का �योग कर के खोल सकते ह�?
Options :
1.  WINDOWS KEY+F
2.  WINDOWS KEY+E
3.  WINDOWS KEY+PAUSE/BREAK
4.  WINDOWS KEY+R
  
  

READING COMPREHENSION
Section Id : 2549894308
Section Number : 2
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 5
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894349
Question Shuffling Allowed : Yes
  



Question Id : 25498920953 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No
Question Numbers : (53 to 57)
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock
Birds and ecosystem

Birds are a special kind of animal species. They have specific characteristics that are common to all of them. All of them have feathers, wings,
two legs, they lay eggs, and are warm-blooded animals belonging to the class Aves. They are an important part of our ecosystem.

Birds are of different sizes and colours. They could be small - as much as 2 inches e.g. the Bee hummingbird or as big as 2.75 meters like an
Ostrich. Scientists are of the opinion that birds are as old as 160 million years.
Some birds cannot fly. The penguin is one such bird. Certain birds like parrots and crows are known to be highly intelligent. The way certain
birds build their intricately woven and safe nests to preserve their eggs indicates that they have many skills.

Birds are very closely connected with the environment. They come to know about the change in weather conditions before humans can predict it.
The presence of a peacock symbolizes rain and good weather while the presence of owls, bats and vultures is said to indicate a bad, unpleasant
weather in an area. Birds are very social. Most communication among them happens through sounds that they make or singing that they do. They
live in flocks, hunt, breed cooperatively and participate in social behaviours.

Many birds are extinct due to hunting. Even birds that live in water like ducks etc. have seen a drastic fall in numbers because of the polluted
lakes and rivers. Birds living close to the river banks consume polluted water and die.

As birds are vital for the balance of this ecosystem we must take adequate steps to preserve them by providing them with safe and clean habitat
for survival.
Sub questions
 
Question Number : 53 Question Id : 25498920954 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension



Form SET 68
BankStatus Mock
According to the passage, which of the following characteristics are common to all birds?  
Options :
1.  They all have wings and feathers.
2.  They are of different shapes and sizes.
3.  They are important for the ecosystem.
4.  They are our friends.
 
Question Number : 54 Question Id : 25498920955 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock
According to the passage, which of the following statements is NOT TRUE?
Options :
1.  Penguins cannot fly.
2.  Parrots are intelligent birds.
3.  Bee hummingbird is very small.
4.  Crows indicate weather.
 
Question Number : 55 Question Id : 25498920956 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock
Birds communicate with each other by ______.



Options :
1.  dancing in the rain
2.  making sounds and singing
3.  telling about weather
4.  staying together in flocks
 
Question Number : 56 Question Id : 25498920957 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock
What is important for the survival of the birds?
Options :
1.  A safe and clean habitat
2.  A balanced ecosystem
3.  Clean lakes and rivers
4.  Rain and good weather
 
Question Number : 57 Question Id : 25498920958 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock
The ‘many skills’ that the writer is talking about refers to the birds’ ability to ______.
Options :
1.  predict the weather



2.  live in groups
3.  sing together
4.  making intricate nests
  
Question Id : 25498920953 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension
Questions : No
Question Numbers : (53 to 57)
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock

प�ी और पा�र��थितक तं�

प�ी िवशेष �कार की पशु �जाितयां ह�। उनकी िविश� िवशेषताएं ह� जो उन सभी के िलए आम ह�। सभी के पंख, दो पैर होते ह�, वे अंडे देते ह�, और एवेस वग� से
संबंिधत गम� खून वाले जानवर होते ह�। वे हमारे पा�र��थितकी तं� का एक मह�पूण� िह�ा ह�।

िभ�-िभ� आकार और रंगो ंके प�ी होते ह�। वे छोटे हो सकते ह� - लगभग 2 इंच, उदा. मधुम�ी, हिमंगबड� या शुतुरमुग� की तरह 2.75 मीटर से भी बड़े ह�।
वै�ािनको ंका मानना है िक प�ी 160 िमिलयन वष� पुराने ह�।
कुछ प�ी उड़ नही ंसकते ह�। प�गुइन एक ऐसा प�ी है। कुछ प�ी तोते और कौवे की तरह ब�त बु��मान माने जाते ह�। िजस तरह से कुछ प�ी अपने अंडे को
बचाने के िलए अपने जिटल बुने �ए और सुरि�त घोसंले का िनमा�ण करते ह�, उससे यह संकेत िमलता है िक उनके पास कई कौशल ह�।

प�ी पया�वरण से ब�त िनकटता से जुड़े होते ह�। लोगो ं�ारा भिव�वाणी करने से पहले उ�� मौसम की ��थित म� बदलाव के बारे म� पता चल जाता है। मोर की
उप��थित बा�रश और अ�े मौसम का �तीक है जबिक उ�ू, चमगादड़ और िग�ो ंकी उप��थित �े� म� बुरे, ख़राब मौसम को इंिगत करता है। प�ी ब�त
सामािजक होते ह�। उनम� से अिधकतर संचार �िन के मा�म से होता है जो वे करते ह� या गाते ह�। वे झंुड म� रहते ह� और सामािजक �वहार म� भाग लेते ह�।

िशकार के कारण कई प�ी िवलु� हो जाते ह�। यहां तक िक बतख आिद जैसे पानी म� रहने वाले पि�यो ंम� �दूिषत झीलो ंऔर निदयो ंकी वजह से सं�ाओ ंम�
भारी िगरावट देखी गई है। नदी के िकनारे रहने वाले प�ी �दूिषत पानी का उपभोग करते ह� और मर जाते ह�।

चंूिक प�ी इस पा�र��थितकी तं� के संतुलन के िलए मह�पूण� ह�। हम� जीिवत रहने के िलए उ�� सुरि�त और �� आवास �दान करके उ�� संरि�त करने के
िलए पया�� कदम उठाने चािहए।
Sub questions
 



Question Number : 53 Question Id : 25498920954 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock

लेख के अनुसार, िन�िल�खत म� से कौन सी िवशेषताएँ सभी पि�यो ंके िलए सामा� ह�?
Options :
1.  सभी के पास पंख ह�।
2.  वे िविभ� आकृित और आकार के होते ह�।
3.  वे पा�र��थितकी तं� के िलए मह�पूण� ह�।
4.  वे हमारे दो� ह�।
 
Question Number : 54 Question Id : 25498920955 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock

लेख के अनुसार, िन�िल�खत म� से कौन सा कथन सही नही ंहै?
Options :
1.  प�गुइन उड़ नही ंसकते ह�।
2.  तोते बु��मान प�ी ह�।
3.  मधुम�ी हिमंगबड� ब�त छोटे ह�।
4.  कौवे मौसम का संकेत देते ह�।
 
Question Number : 55 Question Id : 25498920956 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock

प�ी एक-दूसरे के साथ िकस तरह से संवाद करते ह�?
Options :
1.  वषा� म� नृ� कर के।
2.  आवाज़ और गायन कर के।
3.  मौसम के बारे म� एक दूसरे को बता के।
4.  झंुड म� एक साथ रह के।
 
Question Number : 56 Question Id : 25498920957 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock

पि�यो ंके अ��� के िलए �ा मह�पूण� है?
Options :
1.  सुरि�त और साफ आवास
2.  संतुिलत पा�र��थितक तं�
3.  �� झील� और निदयां
4.  बा�रश और अ�ा मौसम
 
Question Number : 57 Question Id : 25498920958 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value



Item Year CPCT 2021
Topic Reading Comprehension
Form SET 68
BankStatus Mock

लेखक जब पि�यो ंके 'कई कौशल' के बारे म� बात करता है तो वह िकसे संदिभ�त करता है?
Options :
1.  मौसम की भिव�वाणी करना
2.  समूहो ंम� रहना
3.  एक साथ गाना
4.  पि�यो ं�ारा जिटल घोसले बनाना
  
  

QUANTITATIVE APTITUDE
Section Id : 2549894309
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894350
Question Shuffling Allowed : Yes
  
Question Number : 58 Question Id : 25498914246 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Number System



Sub Topic BODMAS Rule
Objective Understanding
Form SET 69
BankStatus Mock
What approximate value should come in place of the question mark (?) in the following expression?

96.996 × 9.669 + 0.96
Options :
1.  860
2.  870
3.  1020
4.  940
  
Question Number : 58 Question Id : 25498914246 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Number System
Sub Topic BODMAS Rule
Objective Understanding
Form SET 69
BankStatus Mock

िन�िल�खत �ंजक म� �� िच� (?) के �थान पर अनुमािनत मान �ा आएगा?

96.996 × 9.669 + 0.96
Options :
1.  860
2.  870
3.  1020
4.  940
  



Question Number : 59 Question Id : 25498929335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Arithmetical Progression
Sub Topic Arithmetic reasoning
Objective Application
Form SET 69
BankStatus Mock

Options :
1.  

2.  

3.  

4.  

  
Question Number : 59 Question Id : 25498929335 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Arithmetical Progression
Sub Topic Arithmetic reasoning
Objective Application
Form SET 69
BankStatus Mock



Options :
1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498928950 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Elementry Stats and Prob.
Sub Topic Graphs
Objective Understanding
Form SET 69
BankStatus Mock

Options :
1.  

2.  

3.  

4.  

  
Question Number : 60 Question Id : 25498928950 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Elementry Stats and Prob.
Sub Topic Graphs
Objective Understanding
Form SET 69
BankStatus Mock

Options :
1.  

2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498929434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Trigononometry
Sub Topic Trigononometry
Objective Understanding
Form SET 69
BankStatus Mock

Options :
1.  



2.  

3.  

4.  

  
Question Number : 61 Question Id : 25498929434 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Trigononometry
Sub Topic Trigononometry
Objective Understanding
Form SET 69
BankStatus Mock

Options :
1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498928910 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value



Difficulty Level Difficult
Item Year CPCT 2021
Topic Arithmetic
Sub Topic Arithmetic reasoning
Objective Knowledge
Form SET 69
BankStatus Mock

Options :

1.  

2.  

3.  

4.  

  
Question Number : 62 Question Id : 25498928910 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Arithmetic
Sub Topic Arithmetic reasoning
Objective Knowledge
Form SET 69
BankStatus Mock

Options :



1.  

2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498929358 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Geometry
Sub Topic Geometry
Objective Application
Form SET 69
BankStatus Mock

Options :
1.  

2.  

3.  

4.  

  
Question Number : 63 Question Id : 25498929358 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :



Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Geometry
Sub Topic Geometry
Objective Application
Form SET 69
BankStatus Mock

Options :
1.  

2.  

3.  

4.  

  
  

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549894310
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894351
Question Shuffling Allowed : Yes
  



Question Number : 64 Question Id : 25498910049 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Logical Reasoning
Sub Topic Alphabet Test
Objective Application
Form SET 68
BankStatus Mock
Which of the following words will come third if all of them are arranged alphabetically as in a dictionary?
Options :
1.  Gradin
2.  Gradient
3.  Graduate
4.  Grading
  
Question Number : 64 Question Id : 25498910049 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Logical Reasoning
Sub Topic Alphabet Test
Objective Application
Form SET 68
BankStatus Mock

चार श� िदये गये ह�। यिद सभी श�ो ंको एक श�कोश के अनुसार वणा�नु�म म� �व��थत िकया जाता है, तो तीसरे �थान पर कौन सा श� आयेगा?
Options :
1.  Gradin
2.  Gradient



3.  Graduate
4.  Grading
  
Question Number : 65 Question Id : 25498919607 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Verbal Reasoning
Sub Topic Best description
Objective Knowledge
Form SET 68
BankStatus Mock
Select the alternative with the most appropriate description about these three words.

Press : Television : Cinema
Options :
1.  They are means of entertainment.
2.  They are means of mass media.
3.  They give worldwide news.
4.  All are public undertakings.
  
Question Number : 65 Question Id : 25498919607 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Verbal Reasoning
Sub Topic Best description
Objective Knowledge
Form SET 68



BankStatus Mock

इन तीन श�ो ंके संबंध म� सबसे उिचत िववरण वाले िवक� का चयन कर�।

�ेस : टेलीिवज़न : िसनेमा
Options :
1.  वे मनोरंजन के साधन ह�।
2.  वे मास मीिडया के साधन ह�।
3.  वे दुिनया भर की खबर�  देते ह�।
4.  सभी प��क अंडरटेिकंग ह�।
  
Question Number : 66 Question Id : 25498910248 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Logical Reasoning
Sub Topic Analogy
Objective Knowledge
Form SET 68
BankStatus Mock
Loiter is related to Dwindle in the same way as Impugn is related to:
Options :
1.  Challenge
2.  Gamble
3.  Confiscate
4.  Revenge
  
Question Number : 66 Question Id : 25498910248 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value



Difficulty Level Medium
Item Year CPCT 2021
Topic Logical Reasoning
Sub Topic Analogy
Objective Knowledge
Form SET 68
BankStatus Mock

धीरे चलने का दुब�ल होने से वही संबंध है जो वाद-िववाद करने का ______ से है।
Options :
1.  चुनौती देने
2.  जुआ खेलने
3.  अिधहरण करने
4.  बदला लेने
  
Question Number : 67 Question Id : 25498941127 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Logical Reasoning
Sub Topic Alpha Numeric Series
Form SET 68
BankStatus Mock
Instruction: Study the following letter-number sequence to answer the question below.

E & G B D M 4 N K H 2 A C Z S V 3 F 1 J L O Q 5 P R

Question: If every third letter/number starting from the right replaces successive days of the week starting from Monday, then which letter will
replace Thursday?
Options :
1.  A
2.  F



3.  S
4.  Z
  
Question Number : 67 Question Id : 25498941127 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Logical Reasoning
Sub Topic Alpha Numeric Series
Form SET 68
BankStatus Mock

अनुदेश : नीचे िदए गए �� का उ�र देने के िलए िन�िल�खत अ�र-सं�ा अनु�म का अ�यन कर� :

E & G B D M 4 N K H 2 A C Z S V 3 F 1 J L O Q 5 P R

�� : यिद दायी ंओर से ��ेक तीसरा अ�र / सं�ा सोमवार से शु� होने वाले स�ाह के सभी िदनो ंको �मागत �प से �ित�थािपत करता है, तो बृह�ितवार
को कौन सा अ�र �ित�थािपत करेगा?
Options :
1.  A
2.  F
3.  S
4.  Z
  
Question Number : 68 Question Id : 25498919650 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Data Interpretation
Sub Topic Word triad



Objective Knowledge
Form SET 68
BankStatus Mock
Three words are given, which are related in some way. Select the option in which the three words are related in the same way.

Hunt : Pleasure : Panic
Options :
1.  Death : Disease : Germs
2.  Game : Match : Win
3.  Theft : Gain : Loss
4.  Rain : Cloud : Flood
  
Question Number : 68 Question Id : 25498919650 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Data Interpretation
Sub Topic Word triad
Objective Knowledge
Form SET 68
BankStatus Mock

नीचे तीन श� िदए गए है िजनमे एक िविश� स�� है। उस िवक� का चयन कर�  िजसके तीन श�ो ंम� ठीक उसी तरह का स�� है।

िशकार : आनंद : आतंक
Options :
1.  मृ�ु : रोग : कीटाणु
2.  खेल : मैच : जीत
3.  चोरी : लाभ : हािन
4.  बा�रश : बादल : बाढ़
  



Question Number : 69 Question Id : 25498919905 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Verbal-Logical Reasoning
Sub Topic Odd word-pair out
Objective Understanding
Form SET 68
BankStatus Mock
In each of the following, four words have been given, out of which three are alike in some manner, while the fourth one is different. Choose out
the odd one.
Options :
1.  Madagascar
2.  Thailand
3.  Cuba
4.  Greenland
  
Question Number : 69 Question Id : 25498919905 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Verbal-Logical Reasoning
Sub Topic Odd word-pair out
Objective Understanding
Form SET 68
BankStatus Mock

नीचे िवक�ो ंम� चार श� िदए गए ह� िजनम� से तीन िकसी �कार से एक जैसे ह�, जबिक एक इनसे िभ� है। उस िभ� श� की पहचान कर�।
Options :
1.  मेडागा�र



2.  थाईल�ड
3.  �ूबा
4.  �ीनल�ड
  
  

GENERAL AWARENESS
Section Id : 2549894311
Section Number : 5
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894352
Question Shuffling Allowed : Yes
  
Question Number : 70 Question Id : 2549895408 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Science and Technology
Objective Knowledge
Form SET 69
BankStatus Mock
Branch of biology in which we study about relationship between living and their environment is called:
Options :
1.  Physiology
2.  Genetics



3.  Ecology
4.  Geology
  
Question Number : 70 Question Id : 2549895408 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Science and Technology
Objective Knowledge
Form SET 69
BankStatus Mock

जीव िव�ान की वह शाखा कौन सी है, िजसम� हम जीवो ंऔर उनके पया�वरण के साथ उनके संबंधो ंके बारे म� अ�यन करते ह�:
Options :
1.  िफिजयोलॉजी (Physiology)
2.  आनुवंिशक िव�ान (Genetics)
3.  प�र��थितकी (Ecology)
4.  भूिव�ान (Geology)
  
Question Number : 71 Question Id : 25498912774 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Sports
Objective Knowledge
Form SET 69
BankStatus Mock
In which year were the first Winter Olympic Games held?
Options :



1.  1896
2.  1904
3.  1912
4.  1924
  
Question Number : 71 Question Id : 25498912774 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Easy
Item Year CPCT 2021
Topic Sports
Objective Knowledge
Form SET 69
BankStatus Mock

शीतकालीन ओलंिपक खेलो ंका आयोजन पहली बार िकस वष� म� �आ था?
Options :
1.  1896
2.  1904
3.  1912
4.  1924
  
Question Number : 72 Question Id : 25498912516 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Indian Economy
Objective Knowledge
Form SET 69
BankStatus Mock



The Geysers, a large steam reservoir north of San Francisco, USA, is the world’s largest source of:
Options :
1.  coal
2.  geothermal power
3.  hydropower
4.  natural gas
  
Question Number : 72 Question Id : 25498912516 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic Indian Economy
Objective Knowledge
Form SET 69
BankStatus Mock

गीज़र, उ�री सान�ांिससको, USA म�, भाप का सबसे बड़ा कंुड़, िव� म� ______ का सवा�िधक �ोत है।
Options :
1.  कोयला
2.  भू-तापीय (िजयोथम�ल) ऊजा�
3.  जल िवद्युत
4.  �ाकृितक गैस
  
Question Number : 73 Question Id : 25498941128 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic General Knowledge
Form SET 69



BankStatus Mock
Sundarbans of Eastern India is an example of:
Options :
1.  Forest Ecosystem
2.  Mangrove Ecosystem
3.  Grassland Ecosystem
4.  Marine Ecosystem
  
Question Number : 73 Question Id : 25498941128 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2021
Topic General Knowledge
Form SET 69
BankStatus Mock

पूव� भारत म� ��थत संुदरबन ______ का उदाहरण है।
Options :
1.  वन पा�र��थितक तं� (फॉरे� ईकोिस�ेम)
2.  मैन�ोव पा�र��थितक तं� (मै��ोव ईकोिस�ेम)
3.  घास के मैदान पा�र��थितक तं� (�ैसल�ड़ ईकोिस�ेम)
4.  समु�ी पा�र��थितक तं� (मरीन ईकोिस�ेम)
  
Question Number : 74 Question Id : 2549895388 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Indian History and Geography
Objective Knowledge



Form SET 69
BankStatus Mock
Wasim Akram of Pakistan is associated with:
Options :
1.  politics
2.  martial law
3.  nuclear tests
4.  cricket
  
Question Number : 74 Question Id : 2549895388 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Indian History and Geography
Objective Knowledge
Form SET 69
BankStatus Mock

पािक�ान के वसीम अकरम िकस �े� से जुड़े ह�:
Options :
1.  राजनीित
2.  माश�ल लॉ
3.  परमाणु परी�ण
4.  ि�केट
  
Question Number : 75 Question Id : 25498929802 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021



Topic Science and Technology
Sub Topic Chemistry
Objective Knowledge
Form SET 69
BankStatus Mock
Which of the following groups of gases contributes to the ‘Green House Effect’?
Options :
1.  Carbon dioxide and Methane
2.  Ammonia and Ozone
3.  Carbon monoxide and Sulphur dioxide
4.  Carbon tetrafluoride and Nitrous oxide
  
Question Number : 75 Question Id : 25498929802 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Question Key Details :
Key Value
Difficulty Level Difficult
Item Year CPCT 2021
Topic Science and Technology
Sub Topic Chemistry
Objective Knowledge
Form SET 69
BankStatus Mock

िन�िल�खत म� से कौन सा गैस समूह '�ीन हाउस �भाव' के िलए उ�रदायी होता है?
Options :
1.  काब�न डाइऑ�ाइड और िमथेन
2.  अमोिनया और ओजोन
3.  काब�न मोनोऑ�ाइड और स�र डाइऑ�ाइड
4.  काब�न टेट� �ुओराइड और नाइट� स ऑ�ाइड
  
  

Mock



Group Number : 2
Group Id : 2549892792
Group Maximum Duration : 5
Group Minimum Duration : 5
Show Attended Group? : No
Edit Attended Group? : No
Break time : 1
Mandatory Break time : Yes
Group Marks : 0
Is this Group for Examiner? : No
  
  

English Mock
Section Id : 2549894312
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894353
Question Shuffling Allowed : No
  
Question Number : 76 Question Id : 25498940961 Question Type : TYPING TEST
Question Key Details :
Key Value
Difficulty Level Medium
Item Year CPCT 2018
Form Mock
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork,
socializing, decision making, independent and responsible living and more. It aids the overall development of a child and children have



fun during this process as they get to explore new arenas.
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Evaluation Mode : Non Standard
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes
  
  

Actual
Group Number : 3
Group Id : 2549892793
Group Maximum Duration : 15
Group Minimum Duration : 15
Show Attended Group? : No
Edit Attended Group? : No
Break time : 0
Group Marks : 0
Is this Group for Examiner? : No
  
  

English Typing Test
Section Id : 2549894313
Section Number : 1
Section type : Typing Test
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0



Enable Mark as Answered Mark for Review and Clear Response : Yes
Sub-Section Number : 1
Sub-Section Id : 2549894354
Question Shuffling Allowed : No
  
Question Number : 77 Question Id : 25498928772 Question Type : TYPING TEST
Question Key Details :
Key Value
Item Year CPCT 2021
Form SET 52
Nowadays, keeping yourself motivated has become very important. In this society of letting people down in every way has encouraged
everyone to put a step towards motivating themselves. Here are six ways that will help you to keep yourself motivated and keep you
moving forward in every situation. Build a business around your passion. When you do something you truly love it is not hard to find the
motivation needed to succeed. If you are involved in an industry that bores you it will be hard to find that motivation. Always have long-
term and short-term goals. Both short term and long term goals give you something to work for, and including short-term goals make
sure that you are able to taste success on a regular basis providing further motivation to push you towards achieving the long-term goals.
Be extremely positive. When you are constantly cheerful you focus on just the positives, which helps you stay motivated and focused on
reaching your goals. The minute you start to bring negative thoughts into your mind is the moment your positiveness mixes up in the
sand. Commit to the end goal. Success often comes to those who take big risks, and big risks can result in failures. There are very few
who hit wonders as most successful entrepreneurs have experienced failure at one point. Even if you have failed in the past, commit to
your end goal and don not think about those past failures or the possibility of failing again. It could happen but you could also be the
next success story. This whole story comes to the above one that if you lose your confidence of doing better you will never get success.
Surround yourself with likeminded people. The company you surround yourself with has a direct influence on how you behave, both in
your personal life and in the workplace. People around you decides the energy that keeps on rotating around your head. You should be
very serious in the choice of environment where you want to live in. Establish a personal reward system. It is always nice to be rewarded
for your hard work and you can all benefit yourself greatly by giving a personal rewards. It does not have to be expensive, sometimes
simple rewards can motivate you to push forward harder. Friday afternoon pizza for the office if all goals are hit for the week is a great
way to keep a team motivated and pushing hard, while you might reward yourself with an early Friday departure from the office if
personal performance goals are successfully completed. Trips, cars and material items can be used for larger goals and they can
encourage that little bit of extra motivation needed to taste victory. Experiment with different rewards to see what works best for you
and your team. At last motivating yourself has nothing to do with the stress and tensions, if you feel motivated then there is nothing that
you cannot do. You can try different tactics to feel confident about what you do and this will lead to motivational journey.
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Paragraph Display : Yes
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Keyboard Layout : Inscript
Show Details Panel : Yes
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